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What's On......
Technology
Education
Centres
Caloundra
Buderim
Yandina

• Get hands on help with all your technology problems.
• Tutorials are presented during each session.
• Internet and intranet access is available.
Windows, Linux and Apple Mac operating systems are supported.
Every Saturday between 9.00 am and 1 pm
Caloundra Youth hall, Queen Street Caloundra, (opposite High School).
Every Wednesday between 9.30 am and 12.00 noon,
Good Life Centre, 100 Buderim Pines Drive, Buderim.
3rd Wednesday of the month between 1.30 pm and 4.00 pm.,
RSL Hall, North Street, Yandina.
20th Anniversary Clean up Australia Day Sunday 7 March 2010
There are a number of ways to be part of the 20th anniversary of Clean Up Australia
Day. Whether you want to go out and about and do a Clean Up or donate to the
organisation. Find out more at http://www.cleanupaustraliaday.org.au/
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From The Editor - Heather Atkinson
Bits'N'Bytes is produced monthly
February to December each year.

visitors.
from

Contributions for the newsletter are always
welcome. Please send copy for the next issue to
reach the editor as early as possible after the
monthly
meeting
or
by
the
deadline:
27
March
2010.
Preferably
Email:editor@sccc.org.au or Snail Mail: The
Editor PO Box 549, Mooloolaba, Qld 4557.
This magazine is created with OpenOffice
and produced in printed form and also
electronically in PDF format.
Copyright - material in this newsletter may be
copied in other publications provided that
copyright rests with the Sunshine Coast
Computer Club Inc., This permission is on
condition that reference is made to SCCC (with
original published date) in the reprinted item.
Liability - Although articles in this newsletter
are checked for content, no warranty can be
given for any loss resulting from the use of
material in the newsletter. Articles and
advertisements are printed in good faith and
views and opinions are not necessarily those
held by the club.
SCCC Privacy Statement - In joining the
Sunshine Coast Computer Club please note that
it is a club operated by volunteer members and
operating within the community involving many
activities relating to meetings, instructional and
social functions for members and at times

This requires the keeping of a member data
base and the publication of the names of new
members. The Club guards the member data
base as best as possible and does not publish
member's addresses nor telephone numbers
unless authorized.
At times photographs are taken at meetings and
functions and are sometimes published. Should
you have any problems relating to your personal
privacy which arises or is likely to arise, it is your
duty and responsibility to advise the Club
secretary in writing of the circumstances and
requirements.
What's on Bulletin - What's On Bulletins are
sent once a week, generally on a Monday
afternoon, to all members who have provided the
Club with their email address. These bulletins
give details of up-coming tutorials and topics to be
covered at the various meeting venues. You will
also
find
items
of
interest
and
club
announcements in these bulletins.
Membership
Cards
for
Collection
Membership cards for those members who joined
or renewed membership for the month
ending 20 January 2010 are available for
collection at Caloundra and Buderim meetings.
Cards that have not been collected in the
previous twelve months are also available.
Note - Membership cards show the next renewal
date of membership.

Raffles
Congratulation to Marjorie Payne who won the 4gb Sony ICD-UX91F Direct USB MP3 Digital
Notetaker with ticket number 58.
The next SCCC Raffle will be drawn at the Caloundra
Meeting on Saturday 13 March 2010.
Win an Oregon Scientific Weather Station!
This unit measures and displays: Temperature, Humidity,
Dew point, Wind speed, Wind direction, Wind chill,
Barometric pressure, Daily/cumulative rainfall. Read the
specifications at a Club meeting when you are buying your
ticket. This weather station would be a talking point at your
home.
Tickets are one dollar each.
Help the Club help you by buying tickets in this raffle.
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Treasurer's Report

The audited annual financial report to 31
December 2009 appeared in last month's edition
of Bits'N'Bytes. This is the first financial
statement for 2010. It covers the period 1
January 2010 to 20 February 2010. Subsequent
reports will cover the periods from 21st to 20th
of each month.
Income and Expenditure
1 January 2010 – 20 February 2010
Income
Fundraising
650.49
Interest
67.57
Meetings
3,996.37
Membership fees
3,748.38
Sales
310.55
Total Income
8,773.36
Expense
Audit Fee
1,450.00
Administration
600.00
Fundraising Expenses
368.86
Gifts
72.73
Hall Hire
1,697.60
Internet Service Provider
258.86
Library Expenses
23.63
Office Supplies
39.04
Postage
66.16
Printing/Stationery
349.10
Refreshments and Entertainment
514.51
Software Purchases
75.45
Repairs and Replacements *
1,330.86
Travel re-reimbursement
109.05
Total Expense
6,955.85
Net Income
1,817.51

She announced that the club had had another
successful year, we have not run any courses, as
the present configuration of one on one hands
on help seems to work the best. Members can
then learn at their own pace, what they are most
interested in. The clubs membership has
increased and we have excellent range of
equipment. Heather invited any members with
ideas or requests to email her. As there were no
questions concerning the treasurers report,
Heather proposed that the report be
accepted, this was seconded by Gordon
Pfeiffer and CARRIED
General Business : Peter requested that Les
Thomas take the chair. All committee positions
were declared vacant. Les asked if there were
any more nominations from the floor. He then
read out the list of nominations at hand.
Position

Nominee

Nominated by

President

Peter Daley

Trevor Jones

Vice
President

Tony Tasker

Leo Kavanagh

Treasurer

Heather Atkinson

Jean Lear

Secretary

Marie McGregor

Hermine Keupper

Administrator

Jean Lear

Marie McGregor

Committee

Tom Bray

Morry Phillips

Andrew Hadland

David Wallis

George Lupsa

Tom Bray

Jim McGregor

Elizabeth
Caithness

Morry Phillips

Tom Bray

Ian Smyth

John E Anderson

Don Wallace

Colin Hood

* Includes replacement printer and laptop.
Minutes of the Annual General Meeting
Held at Caloundra Community Youth Hall
6th February 2010
Meeting: Commenced 10.00 am
Apologies: Peter Dodwell,
Presidents Report: Outgoing President Peter
Daley thanked volunteers and committee
members for a great team effort for 2009. A
special thanks
to Peter Dodwell, who was
retiring after serving many years vice president
and to John Hough, also retiring, who has been a
committee member for many years.
Treasurers
Report:
Heather
Atkinson
presented the Treasurers Annual Report for 2009.
The annual operating statement and balance
sheet as prepared by our auditors report is
published in February's Bits'N'Bytes. Heather
invited any members wishing to view the full
auditors statement to see her after the meeting.

All the nominations were accepted and the new
committee was voted in. Les wished the club all
the very best for the coming year.
Peter
Daley
then
suggested
that
life
memberships be given to Heather Atkinson and
Jean Lear. This motion was then Proposed by
Barry Wilson and seconded by John Hough
and CARRIED
New Members: Judy Barker, Mike Dean,
George Moss, Susan Adcock, Neville and Marilyn
Berry, Barbara Boardman, Ann Larsen, Barbara
Matthew, Gail Parker, Marjorie Smith, Michael
Walsh. The following members have rejoined
after an absence Neville and Pam Chadwick, Tom
Gillanders, Barry Hedges.
Meeting Closed at 10.40am
Marie McGregor Sec.
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Blue Ray by Peter Daley

compliant.

Blue Ray is the latest disc movie technology that
promises a great improvement in picture, and
sound quality. Blank Blue Ray disc are available
at present for data storage that can store 25 GB
per single layered, and 50 GB per dual layered.
This format is open-ended, with a possible
storage limit of 200 GB. So it could become the
next high volume storage media replacing DVD
discs.

Even if the hardware and software you
are using is all legal, and you have
installed Content and DRM compliant Blue
Ray software, disc player, video card, and
Blue Ray compliant monitor it may not
work. All the bits may not talk to each
other for some strange technical reason!
So after many hours of technical support
and research you may be faced with more
expense, and have no choice but to
purchase and try another compliant video
card, different software, or monitor to get
it all working happily together.

It main purpose at present is to act as a medium
to distribute the latest high definition moves,
(High-definition video is 1920×1080 pixel
resolution / 60 frames per second / 24 frames
per second). If you buy a dedicated stand alone
Blue Ray player you just put the disk in and play
it. Getting Blue Ray to work on an computer can
be whole lot more involved.
It is to do with the fact that you need a fairly fast
computer, and have a Blue Ray player installed
plus several layers of Content Management &
Digital Rights Management (DRM). The computer
Blue Ray player looks just like a DVD player,
some are multi players that can read older
technologies like CD /DVD discs. Some more
expensive players can read and burn Blue Ray
data storage disks as well as play Blue Ray
Movies. Price ranges for Blue Ray Players are
$200 to over $500 depending on what the player
can do.
If you are looking at getting Blue Ray movies
playing on an older computer, most of you
should just forget the idea. Because of several
layers of Content Management & Digital Rights
Management (DRM), getting all the hardware
parts to work together can be a nightmare. See
all the hardware has to be certified to be Content
and DRM certified and even then it may not work
together. You also need Content and DRM
certified software to play Blue Ray discs.

Alternatively you could purchase a
computer that is already set up with
everything, content and DRM compliant,
and ready to play Blue Ray movies out of
the box.
In reviews of Blue Ray movies reviewers
have been complaining that the sound
and video quality has not been up to the
Blue Ray standard on lots of movies. This
is because some content creators are
capitalizing on the Blue Ray hype, and
supplying movies with second rate video
and sound quality. They then get top
dollar for second rate material.
There are some very well made Blue Ray movies.
I suggest reading reviews before purchasing any
movie. There are no where near the number of
movies available in Blue Ray format compared to
DVD, which most people are happy with. Now
the industry is pushing 3D as the next big thing!
It is all about getting you to spend money on
new technologies. :)
© Peter Daley 2010

Blue Ray video movies have encryption to
prevent copying and the Content and DRM looks
to see if the hardware or movie disc has been
tampered with. In other words to see if the Blue
Ray content is being pirated.
It can,
1. See if a player's keys have been
changed.
2. Patch an insecure Content and DRM
certified system.
3. Stop the viewing of Blue Ray content if
any of the hardware, or software is not
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The EasyCap USB Video Capture Adapter by
Heather Atkinson

Q: Can the EasyCap record audio tapes onto my
computer?

The Sunshine Coast Computer Club owns a large
variety of equipment which it allows members to
borrow.

A: It can because it is just an interface for audio
and video inputs into the computer. BUT the
software provided is for recording videos with
audio on to the computer and not just solely
audio. You would want to use an audio program
such as Audacity for recording audio from audio
tapes, records or radio.

One such piece of equipment is the EasyCap
USB Video Capture Adapter. With it you can
capture both video and audio so it can capture
video from your old VHS tapes and audio from
your favourite old LP's and cassettes.
It provides
method for
transferring
the need for

an economical and convenient
taking old video and audio and
it to a personal computer without
a soundcard.

It is small in size and uses either RCA or S-video
connections, so it will allow connection to almost
all devices with RCA connector or S-Video
connector, such VHS, VCR, DVD, TV, DV, analog
camcorder, camera, cassette player, turntable or
radio. These connectors must be outputs and not
inputs, or it will not work.

Q: Can the EasyCap be used to record videos
from other devices such as a Sky box or straight
from a television, or anything along those lines?
A: Yes it can. As long as the device you wish to
record from has the relevant outputs required
(Red, White and Yellow phono video lead). These
must be outputs and not inputs otherwise it will
not work. Check in the devices manual first to
see whether the device has the outputs needed.
Q: Can I copy films onto my computer using the
Easy Capture?
A: Yes you can only for personal use. It is piracy
to copy a film and then sell or lend it to another
person without permission to do so.
This is a real time capture device therefore it will
take 3 hours to record a 3 hour tape, for
example.
While converting your old camcorder tapes to
digital will incur no copyright infringement, It is
wise to make yourself aware of copyright laws
when copying video and audio. Read all about it
at
http://www.copyright.com.au
This site will give you all the information you will
need to know about copyright including

It's incredibly easy to use;
First Install the driver software supplied for the
device to your computer.
The EasyCap also comes with comprehensive
and easy-to-use Ulead Video Studio 10.0 Movie
Wizard editing software to make professionallooking DVD's and presentations in minutes.
Then simply connect the colour coded leads to
the source device such as your video recorder,
camcorder, DVD player or Satellite TV receiver,
then to a USB slot on your computer.
Select, play and with a single click convert your
cherished movies into high quality digital files.
Save them to your computer for copying to DVD
or permanent storage.

What is copyright?
Who owns copyright?
What is copyright infringement?
What do I do if my copyright has been infringed?
How can I obtain permission to copy?
How does copyright work internationally?
How does copyright protect music?
Do journalists own the copyright in their work?
Who owns copyright in photographs?
What are moral rights?
How can I protect my work in the digital
environment?
Does copyright apply to the internet?
This is all useful knowledge to have.

The following are some questions and answers I
found online which might be useful:
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TCP/IP and NAT Explained by Bill Maxwell
TCP/IP:

Transmission Control Protocol /
Internet Protocol

NAT:

Network Address Translation

Two people can communicate effectively when
they agree to use a common language.
Computers work the same way. TCP/IP is the
language computers use to speak with each
other on the Internet. More specifically, TCP/IP is
a set of rules or protocols that defines how
computers address each other and send data to
each other.
Every computer on a TCP/IP network needs to
have a unique address, similar to you needing a
unique address for your house. TCP/IP addresses
are based on 32-bit addresses. But rather than
working with 32 1s and 0s in the Binary number
system, we use decimals to represent IP
addresses. Specifically, we use four decimal
numbers separated by periods. These four
decimal numbers represent the 32 binary digits
separated into four equal parts called octets. An
octet is 8 bits. The highest decimal number that
an octet can contain is 255. The decimal number
256 cannot be represented with 8 bits; therefore,
no IP address has a number greater than 255 in
any octet. A typical IP address: 209.85.173.99
which just happens to be www.google.com.
When you connect to the Internet directly, using
a dial up modem or broadband connection, your
ISP typically assigns you an IP address from a
pool of addresses that it owns. These addresses
are PUBLIC; their location is listed in routing
tables that are a crucial part of the Internet's
standard procedure to guide packets of data as
they move from point to point. When you click a
link to a Web page or check for new messages
on your email server, the outgoing packet
includes your IP address, the server on the other
end of the connection returns the requested data
to your IP address, and the Internet sees to it
that those packets are routed to your computer
properly.
On a Home or Small Office Network, having a
unique Public IP address for every computer is
unnecessary and possible dangerous. By sharing
an Internet Connection, you can get by with a
single Public IP address assigned to a single
hardware device (a ROUTER). Each of the
computers on the local network has a private IP
address that is NOT REACHABLE from the outside
world but is known to other computers on the
local network. To communicate with Web Sites,
external Email servers, and other Internet hosts,

computers on the network funnel their requests
through the Router on the edge of the Network –
the one with the Public IP Address. As each
packet goes out onto the Internet, the gateway
device makes a note of where it came from.
When the return packets arrive, the gateway
machine uses NAT to pass those packets back to
the correct Private IP address on the network.
The Internet Assigned Numbers Authority (IANA)
has reserved three blocks of the IP address
space for use on private networks that are not
directly connected to the Internet:
10. – 10.255.255.255
172.16.0.0 – 172.31.255.255
192.168.0.0 – 192.168.255.255
Routers, switches and residential gateways that
use NAT almost always assign addresses from
these private ranges. The Internet Connection
Sharing feature in your Operating System
assigns private IP addresses in the 192.168.0.x
range. Unlike public IP addresses, which must be
unique across the entire Internet, private IP
addresses need be unique only on your local
network. Although it is technically possible to
use IP addresses from publicly available ranges
on a private network, doing so is not
recommended.
Using private IP addresses offers a significant
security advantage because the computer or
router that is managing the connection through
NAT can inspect each incoming packet and
decide whether to forward it or drop it. If a
computer on the local network requested the
connection, the NAT gateway will forward it; on
the other hand, if a computer outside the
network is trying to make an unsolicited
connection, the gateway assumes that the traffic
is hostile and discards it (Firewall).
When you check your IP Address using
IPCONFIG /ALL and it appears in the 169.254.x.y
range and you can't access the Internet, your
router is not assigning the private address. This
range of addresses is assigned by your computer
using a feature called Automatic Private IP
Addressing (APIPA). APIPA kicks in only when no
DHCP server is available. If you're using ICS or a
router or residential gateway that automatically
assigns IP addresses and your computer is
unable to acquire an IP address from the DHCP
server, APIPA assigns a default address. This
problem is often caused by a faulty network
connection or by a firewall that is configured
incorrectly.
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Continued from Page 6

Disable any third-party security software,
confirm that all physical connections are set up
properly, and run through the Network Setup
Wizard to see if you can repair the problem.

Packets Sent: = 4 Received = 4 Lost = 0 (0%
loss)
This is the results of a good ping test <0% loss>
You can also ping a URL as show below:

Using IPCONFIG and PING:

PING WWW.GOOGLE.COM

To view your private IP Address and Gateway
address, click on START > RUN, then type “CMD”
and click on OK.

IPv6 in Brief:

When the MS-DOS prompt window opens, type
IPCONFIG /ALL and press return.
Looking at the results, the private address of
this computer is on the line “IPV4” (Vista & 7) or
IP Address (XP), which may be something like
this: 192.168.10.7
The router has been set to assign addresses in
this range. The address of the router is on the
line Default Gateway. Use this IP address in the
address field of Internet Explorer to gain access
to the routers configuration files.
Using the PING command. Now that you know
the address assigned to your NIC and of your
router you can use the PING command to test
the connection.
Still in the DOS Command Prompt Window, type
PING the IP address of your router.
PING 192.168.10.1
The Ping command sends out four pings and
waits for a reply and you should receive
something similar to the following:
Reply from 192.168.10.1: bytes=32 bime=1ms
ttl=64

The Internet Protocol that is standard today was
created in the early 1970's. The current version
is Internet Protocol Version 4 (IPv4). Due to the
enormous growth of the Internet, IPv4 is no
longer viable. IPv6 will soon replace IPv4 as the
Internet standard. IPv4 is running out of network
addresses, and routing tables are overflowing.
In IPv4, there are 32 bits in every address. This
means that there are 2^32 or 4,294,969,296
unique IP addresses, and we are running out.
IPv6 uses 128 bit addresses, or 2^128. The
number is too long to type on one line.
Remember IPv4
192.168.0.1

address

looks

like

this:

This is what an IPv6 IP address will look like:
EFDC:BA62:7654:3201:EFDC:BA72:7654:3210
where all 8 octets are shown and is known as the
FULL address.
Some addresses will have several 0's within the
address and to make notation of this address
easier, the nonsignificant and leading 0's can be
dropped using what is called Double-Colon
Notation.
1080:0000:0000:0000:0008:0800:200C:417A
becomes 1080::8:800:200C:417A.

Ping Statistics for 192.168.10.1
A Clever Play on Words
A thief in Paris planned to steal some paintings from the Louvre.
After careful planning, he got past security, stole the paintings, and made it safely to his
van.
However, he was captured only two blocks away when his van ran out of gas.
When asked how he could mastermind such a crime and then make such an obvious error,
he replied,
'Monsieur, that is the reason I stole the paintings. I had no Monet to buy Degas to make the
Van Gogh.'
See if you have De Gaulle to tell this story to someone else.
I put it in Bits'N'Bytes because I figured I had nothing Toulouse.
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Linux Conference Australia by Alan Rice
Linux Australia organise a conference in different
venues each year. In 2009 it was Hobart and in
2010 Wellington in New Zealand was the host.
At this conference that started 16 January 2010
and proceeding for a week, the site for the next
conference was selected from the interested
venues.
Brisbane has been selected for 2011 and have
indicated that they would be conducting it in
February 2011 at a date to be decided.
The time for holding it appears to be about the
middle of January or February.
The Home Unix Machine Brisbane Users Group
(HUMBUG) are the group that put in the bid as
they had for several years after being the host
about eight years previously.
At a briefing by several delegates at the 6th
February meeting it appeared a good Maori
social and a technical event occurred.
At this early stage the conference site proposed
is the Brisbane QUT in the city as about 500
delegates are expected, many from overseas.
No social calendar has been announced at this
early stage but it may be advantageous to
promote the Sunshine Coast as a possible
destination for sight seeing, wining plus dining
and accommodation.
The costing of the conference and social
activities will be available later but a nomination
to attend and also to submit papers is usually
about mid September.
The HUMBUG club President emailed
HUMBUG members on 5th February:

all

“We won hosting of LCA 2011. Congratulations
to the team,and Shaun in particular who ended
up doing the bulk of the work that went into
winning the bid.
The team will now be meeting regularly to get
things organised, starting Sunday 2011-02-07.
I expect they will keep us posted as things
happen. In the mean time, be sure to have a
look
at
the
teams
'brochure
website',
http://followtheflow.org”
If you were to access the above link you would
see the work that has already been started to
promote the event. I include a section from this
promotion.
“We don't yet have a huge lot in the way of firm

plans for LCA 2011. It is after all a year away,
and besides we have been very busy buying
ourselves new tee shirts to celebrate the win. It
has been a lot of fun.
Well it was, right up until someone pointed out
there is more to winning LCA than getting tee
shirts. In fact they said it wasn't about tee shirts
at all. It is apparently about Linux, about Open
Source, about copyleft, and most importantly
about bringing together the people who make
Linux, Open Source and free software a reality.
It is said the spirit of Open Source is embodied
in the way everybody contributes to build
something bigger than any one of us,
something that shows the cooperation on a
massive scale can make the world a better
place. And it can be fun at the same time. It is
also said every cloud has a silver lining. So in
the spirit of Open Source, we want to give you
the opportunity to contribute, to put your stamp
on linux.conf.au 2011.
To inspire the creative juices we're awarding
prizes to the ideas we think are the best. Being
pragmatic people, best in our case means ideas
we can actually use. The top prize is free
professional registration to LCA 2011 and we
hope that will make it well worth your time to
scribble a few notes into the form below. You can
enter as many times as you like”.
When I lived I Brisbane I joined HUMBUG as it
was Linux/Unix based. I am still a member. They
have meetings bi-weekly at rooms in University
of Queensland at St Lucia on Saturdays—4pm to
approx midnight, where lectures and hands-on
demonstrations occur.
Many members bring their computers and are
helpful in linux oriented matters. Humbug's web
site is humbug.org.au.
Also an email system has been set up to inform
all the members of problems and postings are
included as problems are solved. The problems
are linux and open source only, other system
communications are ignored. There is a wide
variety of professional expertise in the group and
help is readily given.
The linux.conf.au 2010 website gives a lot more
information as to the running of the Wellington
conference.
I would hope some of our many Linux using club
members will consider going to this Brisbane
event early next year. I will communicate with he
club any information as it becomes available.
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Getting Up to Serious Monkey Business by
David Wallis

You should see a hash (#) prompt.

Having grabbed your attention. I would like to
raise a more mundane matter – SeaMonkey.
SeaMonkey is a cross platform program
designed to do everything a normal user does
on the world wide web in one package.
SeaMonkey is a free and open source Internet
application suite, which uses the Gecko
rendering engine. It works on many operating
systems. It is very useful, and includes an e-mail
client, a calendar, a HTML editor, an IRC client,
and a web browser. It is made by the SeaMonkey
Council,
formerly
by
Mozilla
Foundation
according to Wikipedia.
On March 10, 2005 the Mozilla Foundation said,
they would not develop the Mozilla Application
suite which included the Netscape web browser,
because Firefox and Thunderbird were more
popular and because of that were more
important for them. The SeaMonkey Council
continued developing it instead, but they had to
rename it to SeaMonkey. The newest version of
its main release version is 2.0.
The web browser of SeaMonkey contains a lot of
features used in new web browsers like tabbed
browsing, pop-up window blocking, e-mail and
newsgroups,
web
editing
software,
spell
checking, and an address book.
Optionally included in the SeaMonkey suite is an
IRC chat application.
Enough Wikipedia … lets cut to the chase. For all
users, download is similar … go to the site and
select your poison. We'll be greedy and select
both Windows and Linux versions as we have a
dual boot system.
Go on line and enter http://www.seamonkeyproject.org/releases/ in your current
browser. I'll do Windows first and put
it in my Adownloads folder then repeat
the process for Linux.
Next the installations … again we will do the
Windows' job first
Turn on your computer, fire up Windows and
navigate to the Adownloads folder. Click on
SeaMonkey 2.0.2.6.exe and follow the prompts.
I install it out of the box, accepting the defaults.
You end up with a SeaMonkey icon on your
desktop. Pause for the Linux mob.
So alright already, the Linux installation is a tad
harder but NOT impossible.
Power up, open a shell and go in as super user.

Now for the smoke and mirrors … cd to /opt and
enter
tar jxvf /home/<username>/Adownloads/
seamonkey-2.0.tar.bz2
changing <username> to your username.
After the smoke dies down go to your desktop
and create an icon (link to application) for
SeaMonkey. Wording for command is
/opt/seamonkey/seamonkey
We are now on an equal footing
because
SeaMonkey runs the same under all systems. So
hit that icon and away we go.
Go to Edit>Preferences>Appearances and tick
mail and newsgroups. This means I have to
enter a password to use the application. You can
change this by telling SeaMonkey to remember
your password.
In the browser settings, I choose blank page but
the choice is yours. Igoogle is popular also
SCCC.
Next, I import my bookmarks. Over the years I
have saved these regularly to my data disk
which is burnt to DVD and saved off site.
I also keep a copy of my address book on the
same disk so they are easy to import.
How you work is such an individual thing. I like
to log in and check my mail first. Then I click on
the bottom left button which opens the browser
side of things.
I have set up my personal toolbar with the sites
I visit regularly and tab browse them. It is easy
to remove such things as mozilla.org,
mozillaZine, mozilladev.org and replace them
with Facebook, Google, The Age, SMH,
Sunshine Coast Daily and so on.
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Open Office Tips by Jean Lear

7. Choose Area to edit the area properties. For
example, you can apply a solid colour, or a
colour gradient.
You can also apply a shadow and transparency to
the area and the shadow.
Choose the Line command in the context menu
to set the border properties.

Extended Tips
You can enable extended tips for all icons every
time your cursor hovers over an icon on the tool
bars
by
choosing
"Tools
Options
OpenOffice.org - General" and enable the
extended help tips. You 1872 may not want to
have extended tips on all the time. You can
enable an extended help text for every icon just
for a limited time. Press Shift+F1 and point the
mouse to an icon. You see the extended help
text. This mode is valid until you click anywhere
or press the Esc key.
Make your own Sticky Notes to Keep in
Open Office Gallery
From - http://blogs.sun.com/oootnt/
Some documents can be brushed up by pasting
sticky notes on the pages. You can create some
nice notes in OpenOffice.org without much
effort. Save them in the Gallery, and then later
you can easily position them to any place on
your pages.

Choose the Text command in the context menu
to define some spacing between text and
borders.
Click outside the text box to leave the selected
object.
Double-click the text to edit the text.
Store the sticky note in the Gallery: Open the
Gallery and in the themes open the Sticky Notes
theme created earlier.
Use drag-and-drop to copy the text box into the
Gallery. This can be a little bit tricky.
1. First you must click the text box to see the
eight handles. When you see the handles you
know that the object is selected.

Create a container for the sticky notes:

2. When you just click and drag the object, it will
not leave the document's pages. So you must
click the text box and hold down the mouse
button for a second or two without moving the
mouse. Then, without letting go of the mouse
button, start moving the mouse to the Gallery.

1. Open the Gallery. Tools > Gallery or click on
the Gallery Icon (looks like a hanging picture)
on the tool bar.

3. Now you can release the mouse button to
drop the text box into the Sticky Notes folder
of the Gallery.

2. Click New Theme... button to create a new
theme. Name it "Sticky Notes" for example.

Apply a sticky note from the Gallery:

Create some notes:

1. With any document open, open the Gallery.
Open the Sticky Notes theme.

In Writer, click the Show Draw Functions
icon on the Standard toolbar. The
Drawing toolbar opens next to the bottom of
the window.

2. Drag-and-drop a text box (also known as a
sticky note now) from the Gallery into the
document. No need to wait a second when
you drag from the Gallery.

2. Click the Text icon (with the letter T on it).
Then drag a rectangle on the page.

3. Double-click the text box to edit the text.
Select the text and choose Format >
Character to change the text colour or other
character properties.

1.

3. Enter some text to keep the text box visible.
You are in text edit mode now.
4. Click outside the text box to leave text edit
mode.
5. Click the text once. Now the text box is
selected as an object. You see eight handles
to move and scale the text box.

By default, the text box is anchored to the
paragraph where you dropped it. You can move
the text box to another paragraph, and the
anchor will follow. You can also change the text
box anchoring to be anchored to the page, or to
a character.

6. Right-click inside the text box to open the
context menu.
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Bits and Pieces
101 Best Free Software Programmes
The link below is to the web page of 101 best
free software programmes.
http://maketecheasier.com/best-101-freecomputer-software-for-your-daily-use
Copy this into to your browser address bar. The
programmes are listed by categories to make
searching the list easier. On the right hand side
of the page are links to further information
(including hints and tips) on the programmes.
Thank you to Graeme Pinniger for pointing this
link out in the Club Yahoo Site.

Does anyone want to try the new (free)
GOOGLE WAVE ?
From Graeme Pinniger
It is best defined as the the e-mail of today.
Every thing is in ‘Realtime,” communication
between parties via written text, audio or video
link. It is far more than e-mail and has elements
of facebook and twitter and other social
interactive programmes plus many other
applications (all free) including brainstorming,
travel planning with Lonely planet links, you
name it , it has it.
To activate the programme you will need to have
or establish a Google account that is easy and
also free. The programme is in limited release
and is only available by invitation of which I have
a number to issue to interested people (on a first
come basis) There are pages of information on
the net just Google it.
Anyone wanting to try please email Graeme at
gpinniger@gmail.com

Web site with detailed Weather Information
The mission statement for the site http://www.willyweather.com.au – is “To gather,
from various sources, the most reliable weather
forecast and observational data worldwide; and
to present that data in the most simple,
innovative and user-friendly ways as possible.“

possible. Australian weather data is sourced from
The Bureau of Meteorology (BoM), The European
Centre for Medium-range Weather Forecasts
(ECMWF), and the National Oceanic and
Atmospheric Administration (NOAA). It is possible
to select your region and see detailed
information about the Weather, Wind, Moon
Phases,
Rainfall,
Swell,
Tides
and
Sunsrise/Sunset for locations all over Australia.
There is a calendar to 'Jump To' dates in
advance. It is a site well worth a look especially if
you have outdoor interests including fishing.

GIVE AWAY - 8 MM PROJECTOR
A Club member has an 8 MM Reel to Reel
Projector
to
give
away.
The
projector
may be viewed at a Buderim Meeting or other
arrangements could be made.
If you are interested in having this projector
please telephone the Club Information Line
54921005 (Leave a message if the telephone is
not answered.) or e mail sccc@internode.on.net

File Extensions – Clear the Confusion
If you come across a file or e-mail attachment
with an unknown file extension, you
can look up the file association at the site http://www.fileinfo.net
This web site contains a search-able database of
thousands of file extensions with detailed
information about the associated file types.
Each entry contains information about the file
format, a description of the file, and the
programme or programmes that can open the
file. Programmes for opening the files are listed
for Macintosh, Windows, and Linux platforms.
Simply use the search box in the top-left corner
of each page to search for a specific extension or
browse by file type using the links on the left
side of the page. For an overview of common file
types, visit the "Common File Extensions" page,
which includes a list of important file formats you
should know.

The name comes from the term 'willy-willy', a
weather condition similar to a dust devil or minitornado.
The site gathers, from various sources, the most
reliable weather forecast and observational data
worldwide; and presents that data in the most
simple, innovative and user friendly ways as
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Problem Steps Recorder in Windows 7 by
Heather Atkinson
One of Win7's handiest new tools is the Problem
Steps Recorder. When something goes wrong
with your computer and you need to talk to a
technician to get help, you can find it very
difficult to explain the events that lead up to the
fault occurring. Problem Steps Recorder to the
rescue! It will record the specific sequence of
actions that led to the problem and provide a
detailed
screen-by-screen
view
with
accompanying information. The recording can be
used to quickly identify problems and help
reduce time spent with the help desk.
The Problem Steps Recorder tool is a simple
screen capture utility that grabs screenshots
whenever a mouse move or click is made and
documents all the data into a zipped MHTML
report page that can be sent off directly to the
help desk. Every step of the user’s actions is
logged complete with a screenshot with the item
highlighted, and it even allows the user to
provide commentary on specific details.

Problem Steps Recorder records every mouse
click and key press. It also creates screen shots
and zips the lot into an MHTML file you can send
as an e-mail attachment to tech support. Each
screen shot is captioned with an explanation of
the
action,
e.g.
Problem
Step
1:(Date
Timestamp) User left click on “Start (push
button)” in “Start”.
Recording the steps to reproduce a problem is
what the Problem Steps Recorder was created
for, but you could also use it to produce a
tutorial to show a friend how to do something. To
tidy up your instructions you would want to edit
the html. You might like to remove the word
Problem and the date and timestamp.
Problem Steps Recorder is for Windows 7. You
would have to get something like CamStudio or
Screenrecorder, both of which create videos, for
older versions of Windows.

To launch the Problem Steps Recorder, just go to
“Start”, type “psr.exe” and press “Enter”. Click
Start Record and redo the steps that led to the
problem.

Find Your Membership Number
The member whose number was hidden in the February 2009
edition of Bits'N'Bytes has not responded. There is still time so
take another look at last month's magazine! You are allowed
60 days from the publication date to claim your prize.
Otherwise, the prize is forfeited!
Do you read your Bits'N'Bytes each month? Find your
membership number hidden somewhere in one of the pages
and win five free tickets in the current raffle.
The membership number will be chosen at random and will appear as a four digit number
within the text of the magazine and may be on any page.
Do not forget to thoroughly scrutinize every magazine for your membership number hidden within
the text of articles each month.
The number is placed in the 1872 middle of a sentence like this!
Start looking now! The lucky membership number is hidden somewhere in this month's edition. Is it
yours?
When you find your number contact the club by email at editor@sccc.org.au or phone 54921005
to claim your prize.
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Getting Little Red X's instead of Pictures?
There are several reasons why the Red
X may appear on a web page. Here are
a few of the more common...
The Red x indicates a place where a picture
should be. The fact that the picture does not
show may be something you can fix, but
sometimes the solution is out of your control.

pictures if “Show Pictures” is not checked.
If you are using Windows XP and Outlook Express
you will find that the security option to block
images is turned on after you install Service Pack
2. The solution in this case is to click on Tools –
Options – Security and uncheck the “Block
images and other external content” check box
and then click OK.

It is possible that the pictures for the web page
have not been uploaded to the web server, or
that the web page coding is not correct. If this is
not your web page, there is very little you can do
about it other than to send the webmaster an
email (providing he has supplied an email
address) telling him that the links to the pictures
are broken and then waiting to see if he does
anything about fixing the problem.
Before assuming that the webmaster is at fault,
you might like to have a look at Control
Panel/Internet Options. Click on the “Advanced”
tab and have a look under the “Multimedia”
heading. You can check and uncheck settings
here. You will see the little red x in place of
Corporate Members

Help with Computers
Andrew Hadland Diploma ICT

Peter Daley

Phone 5491 8645
•
•
•
•
•

Help with all aspects of Computer
Functions
Tuition – Emails – Scanning – Video
Editing
Burning CD's / DVD's – Backups
Protection Anti Virus – Spyware –
Firewall
Internet – ADSL Setup

Computer Repairs and Upgrades for
Windows and Linux. Data Recovery,
Computer and Internet Training and
Setup. Home Entertainment and Hi Fi
systems setups and advice. Custom built
computers, all computer systems are
tested before pickup. Award Winning
Web Page Designer!
E-mail: ( Peter Daley)...
PH 0754913279
| Free Books | | Links | | E-mail |

Computer - Repairs – New Systems

Welfare Officer
Sunshine Coast Computer Club
Phone 54925443 Email
gregalach54@westnet.com.au
If you are ill or incapacitated or know of a club
member who needs some assistance or would
like to hear from the Club
contact our Welfare Officer Marie McGregor
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Classified Ads

Classified Advertisements in Bits'N'Bytes - Editorial Policy is that B'N'B Classified Advertisement 1. Are for the use of members only.
2. Items must not be of a business or commercial nature.
3. Items submitted should be limited to a few items - no huge garage sale lists please!
4. Items should preferably be relevant to computers, graphics, video, audio, electrical or
electronic hobbies etc. Adverts for other types of household goods will be accepted only if
there is sufficient room for them.
5. Ads should preferably be forwarded direct to editor@sccc.org.au or phoned in to 54913279.
6. The Editor reserves the right to reject or edit any material .
FOR HIRE OR LOAN

FOR SALE

The Sunshine Coast Computer Club owns data
projectors, laptops, external DVD burners,
scanners, digital cameras,etc.

Alteck Computer
Windows XP Home Edition
Service Pack 2 (build 2600)
80.5 Gigabytes Usable Hard Drive Capacity
960 Megabytes Installed Memory
1gig RAM
Sale Price $220.00

This equipment is available for hire or loan to
members when it is not required by the club for
meetings and presentations.
Contact your club if you need to borrow or hire
equipment.

HP. Flat Bed Scanner Model 320 C
Sale Price $ 60.00

Email: sccc@sccc.org.au
Telephone: 0754921005

Leslie Goodman
lavkigo@southernphone.com.au

FOR SALE

FOR SALE

ASUS Desktop Computer System
Intel Pentium 4CU, 2.66 GHz, 992 MB RAM
Windows WP Home SP3
LG Flatron 19" screen.
Lemark X75 Printer\Copier\Scanner
Multimedia Subwoofer Speaker System
MS Word 2002, MS Office 97
Nero 7, Windows Movie Maker, WMP 11,
C Cleaner, AVG, Paint Shop Pro 8(not installed),
Pinnacle TV
$300 ONO

Siemens "Speedstream" 6520
ADSL Cable or Wireless Gateway/Modem/Router
Paid $140.00 Sell $50.00

Robyn Cameron
54527342

FOR SALE
Dell E772P 17" CRT Monitor
New in carton
$55
Jim Irwin
5493 9324

Linksys Wireless-G ADSL2+ WAG54G2-AU
Cable or Wireless Gateway/Modem/Router
Paid $165.00 Sell $80.00
Both pieces are in good condition and work very
well. All cabling and discs complete.
Selling because we upgraded our home network.
Units available for inspection at SCCC Caloundra
on Saturdays a.m.
Bryan Matthews 5492 3412
beandtee@gmail.com
FOR SALE
Compaq Laptop
Seven months old and with a two year warranty.
Windows Vista Home Basic
Intel CPU at 1.66 Ghz.
1gig. of ram.
Immaculate order.
Asking price $500 o.n.o.
Colin Jones
5439 9994
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CDs Available from SCCC Inc.

Please Print : Name(First)............................................(Last)..............................................................
Address..............................................................City...............................................Post Code.............
Item (Prices include GST)

Number

Club CD - Packed with free software, games and books.

@ $10 each

Bits'N'Bytes Ezine Archives CD - June 1998 to December 2009.
Bits'N'Bytes Ezine Archives CD – trade in your old copy.

@ $10 each
@ $5 each

Multimedia CD - Clip Art, Animations, Midi and Wav files and
background colours to add to cards, emails etc.
Multimedia CD Upgrade (With old version CD returned)

@$10 each
@ $5 each

Postage (for one or more CDs)

$3.00

Post to : SCCC, Post Office Box 384, Caloundra
Enclosed

4551
Total

Cheque / Money Order / Cash

Member

Cost

Surf Watch - Members Web Sites...Submit Yours

Peter Daley

Very Useful Links http://www.ozemail.com.au/~vital1/lstlinks.htm

Peter Daley

Fantasyland Creations http://www.ozemail.com.au/~vital1/

Peter Daley

Daley Positive Personal Development
http://www.ozemail.com.au/~vital1/freebks.htm

Jay Leboutillier

Website Design Centre http://www.websitedesigncentre.com.au/

Technologypals

Corporate member http://www.technologypals.com.au

Bill Maxwell

IT Knowledge Base for Seniors http://it.flexinet.com.au/

Richard Philippe
(Aka Richi Who)

Be Master of Your Life http://www.personal-development-course.com
Richi Who's http://www.psychic-mystic.com

Mathew Carter

Free Online Photo Community http://fotoforfree.com.au
Club Intranet

The Club Intranet is available at all meeting venues. It is packed with up to date free software,
tutorials and back issues of Bits'N'Bytes. Access it from any networked computer at the venue.
Type In your browser address bar:
192.168.1.222 (If you are at Buderim) or 192.168.0.222 (If you are at Caloundra or
Yandina)
President
Vice President
Secretary
Treasurer
Administration Co-ordinator
Committee
Committee
Committee
Committee
Committee
Committee
Committee

Your Committee
Peter Daley
Tony Tasker
Marie McGregor
Heather Atkinson
Jean Lear
Tom Bray
Morry Phillips
George Lupsa
Jim McGregor
Ian Smyth
Andrew Hadland
Don Wallace
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5491 3279 (VOIP)09134402
5476 7129
5492 5443
5444 0886 (VOIP)09110928
5492 1151
5479 3149
5491 1148
5445 3850
5492 5443
5491 9139
5491 8645
0401093692
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SCCC Membership Application/Renewal Form
Applications can be posted to SCCC Inc., P O Box 384, Caloundra, 4551
or presented at a meeting
I wish to apply for membership
I wish to renew my membership

Name(s):

Address:
City:

Postcode:

Phone:
Email:
I will collect my membership card from Caloundra

Buderim

Yandina

Membership fees include the electronic version of the club
magazine.

Amount

Individual

$35

Family

$45

Corporate (Includes a monthly advertisement in the club magazine)

$60

Junior (Under 18 Years of Age)

$20

For the additional cost of $12 you may subscribe to a printed and posted
paper version of the club magazine.
Magazine subscription

$12
Total Enclosed $

Signature:
If after joining you don't receive your magazine within one month,
please contact the Club.
SCCC Office Use
Date Paid:

Amount: $

Receipt Number:

Membership Number:

Signed:

Nominated:
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